


 



            
                				
                                    

                      
        

    
        
    	
                	       
        		
        
		

		    

    
                
			            	_Authors Company		Author Orga			A01 Authors Butlers
	A02 Keywords Authors Team
	А05 Authors Doc Pages


	Authors			A10 User Operations				A11 Find Author
	A12 Create Author
	A19 User Delete


	A16 Edit user data
	A20 User Attributes: WordPress				A21 Name
	A22 Login
	A24 Mail
	A25 Picture
	A25a Author Picture
	A25b WP User Avatar
	A26 Biography
	A26a Biography Testing
	A26b Bios Corrections - Syndication
	A26c WP HTML Author Bio
	A28 Author category


	A30 Additional User Attributes				A31 User Attributes / Channels on DB
	A32 About me & Wikipedia
	A33 My Site / Sales Page
	A34 Twitter
	A36 Other Social Channels
	PRIV A37 Channels for Books
	A38 Economics/Finance
	A39 Programming Channels


	A40 Author Sales Pages				A41 Author Sales Pages
	A42 Author Banners
	A43 You on Ecoblogs


	A50 Author Backend				A51 User Overview
	A52 User Roles
	A53 Load Videos in Author-Backend
	А54 Video Load Author Backend Testing
	A55 Roles in Wordpress


	A70 Author Plugins				A72 Categories Tools
	A74 WP-Footnotes
	A76 Author Snippet


	A80 Advanced Author Plugins				A81 Author Profile Ideas
	A82 Author Profile
	A83 Dynamic Author Home Page
	PRIV A84 Author Sidebar Widget
	A86 Author Menu
	A87 Author Archives
	A88 Dummy Avatars


	A90 Author Product				A91 Author Pages Competition




	Books			B10 Amazon Website				B11 Amazon Website
	B13 Amazon Associate + Widget


	B20 Simple Book Plugins				PRIV B21 Book Snippet
	B22 API Qualification
	B23 Book Author Snippet
	B25 Amazon Link Plugin
	B26 Our Amazon Link


	B30 Books GUI				PRIV B31 Books GUI, Text
	B32 Books Post Type


	B40 Amazon Books Loader				PRIV B41 Changed Associate ID Books Loader
	PRIV B42 Associate, Site, incl. changed Associate
	PRIV B43 Amazon Books Loader
	PRIV B44 Amazon loader Testing


	B50 Amazon Books Backend				PRIV B51 Author Filter
	PRIV B52 Amazon API Job (old)


	B60 Books for our Authors
	B70 Other Books				B71 Book List


	B80 DB and Debugger


	Ecoblogs			Е10 Ecoblogs Input Sites				PRIV Е11 Feedly List
	PRIV Е12 Best Alternative Blogs
	PRIV Е13 Heterodox Sites
	PRIV E14 WebSites from Confluence
	PRIV Е15 100 Best Economic Blogs


	Е20 Ecoblogs Feeds				PRIV Еxx Google Go-Live Tasks: Author Names
	PRIV Е20a Blogs, Categories, Authors
	PRIV Е20b New Feeds (Old)
	PRIV Е21 Bugs on Ecoblogs


	E30 Ecoblogs Functionality				PRIV Е32 Feed Sites - concept
	PRIV Е33 Media Library on Ecoblogs
	PRIV Е34 Media inside Post
	PRIV Е35 Categories and Authors


	E40 Feeds				PRIV Е42 SNBCHF
	PRIV Е43 Austrian
	PRIV Е44 Central Banks
	PRIV Е45 European
	PRIV Е46 Heterodox
	PRIV E47 Leaders
	PRIV Е48 Macro
	Е49 Swiss
	PRIV Е49b Crypto


	E50 Syndicated Blogs Testing				E51 Posts by Category
	PRIV Е51a Ecoblog Testing Format
	PRIV E51c Ecoblogs Bugs Old Format
	E51d Ecoblogs Media Testing
	E52 Posts by Author
	E53 Post Text/Content
	E54 Images inside Posts
	E55 Videos inside Posts
	E56 Widgets
	E58 Media Library: Images
	E59 Full Post Comparison


	E60 Crypto blog
	E90 Old Ecoblogs Testing				PRIV Е91 Austrian
	PRIV Е92 Central Banks
	PRIV E93 European
	PRIV Е94 Heterodox
	PRIV Е95 Leaders
	PRIV Е96 Macro
	PRIV Е97 Swiss
	PRIV Е98 Syndication
	PRIV E99 Very Old Ecoblogs Testing					PRIV E99a Ecoblogs Business Testing
	PRIV E99b Author Go-Live Testing (IT)
	PRIV E99c Author Go-Live Bugs January
	PRIV E99d Author Go-Live Bugs December
	PRIV E99e Author Go-Live Old Bugs
	PRIV E99f Author Go-Live: SG






	PromoteAuthor Sales			S21 Author Sales Problem
	S23 Product Author Sales Product
	S24 Author Model Competitors
	S25 Validation
	S25b USP
	S26 Campaigns
	S27 Owner George Dorgan
	S27b George Dorgan Search
	S28 PromoteAuthor Clients
	S29 Promote Author Project
	T50 Tweet Author				T51 Filled Attributes Stats
	T52 Author Attribute Questions




	SNBCHF			R00 Posts and Effort Entry				PRIV R01 Title
	R02 URL & Manual Keyphrases
	R03 Missed Posts
	R04 Choice of Post
	R05 Urgent Posts
	PRIV R05b Saturday Sunday Posts
	R06a Draft Posts (mig)
	R06b Daily Post Preview (Draft Posts)
	R06c Daily Post Preview (Draft Posts)
	R06d Daily Posts from Confluence
	R07 Delete Drafts
	PRIV R08 Important and Cornerstone
	R09 MoreInfo FeedBack Keylink


	R10 SNBCHF Feeds/Categories				R10a New Feeds
	R10b Old Feed Table
	PRIV R11 SNB, CHF
	PRIV R12 Swiss Markets
	PRIV R13 Swiss and European Macro
	PRIV R14 FX Feed Chandler
	PRIV R15 Global Macro
	PRIV R16a Austrian/Debt
	PRIV R16b Gold Feeds
	PRIV R17 Markets
	PRIV R18 Other Feeds
	R19 Single Posts


	R20 Media on SNBCHF				PRIV R21 Graphs, Images
	PRIV R22 Media Library
	PRIV R23 Caption, ALT Text
	PRIV R24 Media Title
	PRIV R26 Tags on Media
	PRIV R27 Image Popup


	R30 Format on SNBCHF				PRIV R31 Overview
	PRIV R33 Chapters, Sections, KeyWords
	PRIV R35 Tiny Tables
	PRIV R36 Graph Snippets


	R40 People				PRIV R41 Author
	PRIV R44 Books
	PRIV R46 About Box
	PRIV R47 Videos


	R50 Taxonomies, Newsletter				PRIV R51 Categories
	PRIV R52 Category Widgets
	R53 Change/Add Category
	PRIV R54 Categories Cleanup
	R55 Newsletter Planning
	R56 Newsletter Testing
	PRIV R59 Taxonomies Page Cleanup


	R60 FX (Manual)				R61 Daily FX Overview
	R62 Daily FX: EcoGraphs by Subject
	R63 Daily FX: EcoGraphs by Date
	R64 Daily FX Explanations
	R65 Daily FX: Other Things
	R66 Swiss Eco Events
	R67 Sunday: George & Niki Weekend
	R68 Blog Data Update / Datawrapper
	R69 Weekly FX Review
	R69b FX Widget
	R69c Inflation Adjusted Currencies


	PRIV RXX Daily Content Checks
	R70 Swiss and SNB (Manual)				PRIV R71 Swiss Macro Releases
	R72 Swissmacro graphs in PCloud
	PRIV R73 Swiss National Bank Results
	R74 SNB Results Tables
	R75 SNB Sight Deposits and CHF Spec Position
	PRIV R78 Manual Content
	PRIV R79 Balance of Payments


	R80 Video Feeds Input				R81 New Videos theme-based
	R82 German Video Authors
	R82b German Author Not Taken
	R83 German Speakers
	R84 Video Feeds Categories


	R90 SNBCHF Regular				R91 Monthly Tasks


	R98 Advanced Content				PRIV R98a How much money refugees obtain per EU country
	PRIV R98c Peukert, Chapters and Content - Keywords


	PRIV R99 SNBCHF Menu Cleanup
	R107 Atlassian Confluence and Links				PRIV R107a Little Bulgarian dictionary
	PRIV R107b Glossary




	PromoteAuthor SEO			AS11 Author Sites SEO Backlinks
	AS12 Author Sites Keywords
	AS13 SEO Keywords SNBCHF
	AS14 Index Coverage


	Staatenlos
	S92 Staatenlos People


	Group		Group Orga			GO10 Planning and Review				O01 Business Plan & Sponsors
	O01a Business plan May2015
	PRIV O01b Business Plan Support
	PRIV O01c Sponsor Situation September
	PRIV O02 Planning Review Table
	PRIV O04 Milestones 2016
	PRIV O05 Progress 2016/12


	GO01 Group Butlers
	GO10a Planning and Review Old
	GO02 Keywords Group Team
	GO05 Group Doc Pages
	PRIV O99 Org Menu Cleanup


	Legal			L00 Business Model				L04 Aggregation Legal
	L05 Forecast Tools
	L06 Lean Process
	L07 Business Plan Tools
	L09 Milestone 2018


	L10 Legal Form				L11 Stock Ownership Company
	L12 Limited
	L12 Übertrag Sacheinlagen
	L13 Non-Profit Organisation
	L19 Legal Domicile


	L20 GDPR				PRIV L21 Data Protection Reader
	PRIV L22 Data Protection Newsletter
	PRIV L23 Cookies
	PRIV L24 Cookie Policy
	PRIV L25 Privacy Policy
	PRIV C26 Personal Data
	PRIV L27 Data Protection Author
	PRIV L28 GDPR Author Attributes
	PRIV L29 Frontend Anonymisation


	L30 Website Law				PRIV L31 Complaint Action List
	PRIV L32 Complaint History
	PRIV L33 Complaint and Server Location
	PRIV L34 Fair use
	L36 Embed
	L37 Download
	L39 Whois Policy


	L40 Legal agreements				L41 Software Agreement
	L42 Founder Warrant
	L43 Founder's Agreement
	L45 Advisors


	L50 Payments				L59 Common Wallet
	L51 Banks


	L70 Jobs and Personnel				L71a Holiday Planning
	L71 Roles
	L71b Phone Numbers
	L72 Freelancers
	PRIV L73 Tester/Writer
	PRIV L74 Bookkeeper
	L76 Time Sheets
	PRIV L77 Social Security Teleworkers
	L78 Upwork
	PRIV L79 Accenture and BI


	L80 Accounting				L81 Accounting Basic Info
	L82 Client Invoices
	L83 Supplier Bills					PRIV L83d Supplier Bills 2022
	PRIV L83е Supplier Bills 2021
	PRIV L83f Small Bills
	PRIV L83g Supplier Invoices 2020
	PRIV L83h Supplier Bills 2019
	L83j Supplier Invoices 2017
	PRIV L83i Supplier Invoices 2018
	L83k Supplier Invoices 2016
	PRIV L83l Invoice Milos


	L84 Invoices Collector & Accounting Software
	PRIV L85 Get My Invoices
	L86 PRIV Bank Accounts
	PRIV L87 Bookkeeping
	L88 Depreciation


	L90 Tax				L91 Tax Doc Collection
	PRIV L93 Wertschriften
	PRIV L92 Fill Tax Form
	L94 Tricks
	L95 PRIV Tax Dispute
	L96 PRIV Gewinnabsicht
	L97 PRIV Abgrenzung Hobby Gewinnabsicht
	L98 VAT
	L99 Tax Calculation


	PRIV L99 Concept Cleanup


	Sales Channels			C00 Sales Channels Overview
	C10 Newsletter				C11 Email Subscription Comparison
	C12 SMTP
	PRIV G21d Monday Morning Newsletter
	C18 Email Marketing


	C20 Mailpoet				C21 Mailpoet Setup
	C22 Plugin and Licenses
	C23 Subscribers Cleanup
	C23a Subscribers Migration
	PRIV C24 Sending Mails SMTP
	C25 Subscription and Confirmation
	C25a Sign-Up Confirmation Catcha
	PRIV C26 Other Problems
	C27 Design and Customization
	C27a Custom Code
	C28 Mailpoet DB Structure
	PRIV C29 Improvements


	C30 RSS
	C40 Comments				PRIV S41 Import External Comments
	PRIV S42 Comment systems Comparison
	S44 Comment Spam					PRIV S49a Compare different spam plugins


	S48 User Comments


	C50 Community				PRIV S51 Create a Community
	PRIV S52 Social followers into subscribers
	PRIV S53 Community and Access Rights
	PRIV S54 Membership
	PRIV S55 Follow, Subscribe, Register, Donate Logic					PRIV S55a Login & Register Process
	PRIV S55b Login & Register & Forgot password
	PRIV S55c Login via Social & Newsletter
	PRIV S55d Register
	PRIV S55e Login


	PRIV S57 Dummy Profiles
	PRIV S58 Social Profiles Old
	S59 Crisp


	C60 Contacts				ST61 Contact Requests Process
	PRIV S63 Contact Form Plugin
	PRIV S64 Contact Spam
	PRIV S65 Contact Classification
	PRIV S67 Captcha
	PRIV S68 Old Feedback


	C70 Sales Agent				G27a Commision Network


	C80 Mailchimp & Campaigns				C81 Mailpoet vs. Mailchimp


	C99 Channels Menu Cleanup


	Simple Sales			S01 Blogs Sales Clients
	S08 Blogs Sales Pricing


	Other Ideas			I10 Reputation Tools
	I20 WebSummit Ideas
	I30 News Company				I32 Before it News Product					S51 Company News Problems


	I39 Before it News Law




	Startup			G80 Startup Help				G82 Impact Hub
	L64 Startup Accelerators
	L65 Swiss Startups
	G86 CoFound Me


	G90 Founders				G90a Founders Institute
	G91 Orientation (1)
	G92 Vision (2)
	G93 Customer Development (3)
	G94 Revenue (4)
	G95 Branding Design (5)
	G96 Mentor Idea Review (6)
	G97 Legal Intellectual Property (7)
	G98 Go to Market (8)
	G98b Product Development (9)
	G98d Mentor Progress Review (10)
	G98e Hiring & Onboarding (11)
	G98f Growth (12)
	G98g Equity & Funding (13)
	G98i Graduation (14)
	G98k Working Group
	G98l rating
	G98l Feedback


	G100 Startup Guides				G102 Founder Guide
	G103 Idea Development Guide
	G104 Hotseat Guide
	G105 Contacting Mentors
	G106 Initial Customer Development
	G107 Revenue Steps
	G108 Legal Interview Questions
	G109 Metrics and Financial Definitions
	G101 Incorporation Guide
	G110 Logo Brief Guide
	G111 Founder Institute Assignments
	G112 Legal Concepts
	G113 Core Activities
	G114 Advisor Contact
	G115 Roles and Job Descriptions
	G116 Onboarding in a Startup
	G117 Pitch Deck Structure Guide
	G118 Fundraising Strategy Guide
	G119 Company File Folder System
	G120 Customer Archetype
	G121 Development Shop Partners
	G122 How to Raise a Founding Round
	G123 Best of Videos
	G125 1.  Best of Vision and Ideas
	G126 2. Research Best
	G127 3. Naming Best
	G128  4. Hiring Best
	G129 5. Product Roadmap
	G130 6. Best of Revenues
	G131 7. Best of Legal and IP
	G132 9. Best of Branding
	G132 8. Best of Outsourcing
	G134 Co-founder & Early Team Member Recruitment Strategy
	G135 11. Best of Funding
	G136 Customer Problem
	G137 Fundraising: Early-stage Fundraising Strategy




	Social Media			T10 Twitter Account				T11 Twitter Account List
	T12 Twitter Follow
	T13 Twitter Notifications


	T20 Autotweet				T21 AutoTweet Competition
	T22 Revive Old Posts Autotweet
	T23 Revive Old Post Base Configuration
	T24 Revive Old Post Customisation
	T25 Revive Old Posts Our Code Changes
	T26 Revive Old Posts Problems
	Т29 Social Autoposter (old tool)					Т29A Social Autoposter Config




	T30 ReTweet				Т31 Auto-Retweet Overview
	Т32 Auto-Retweet with IFTT (not used)
	Т33 Roundteam


	T40 Twitter Tools				T29B Social Autoposter testing
	T42 Twitter Management Tools
	T43 Multi-author Tweeting
	T44 Twitter Lists
	Т45 Twitter Test Page
	Т46 Embedded Timelines
	T49 Twitter Statistic


	T60 LinkedIn
	T80 Facebook				T75 WP to Facebook
	S81 Facebook Page
	S82 Twitter to Facebook
	S83 Wordpress to Facebook
	S85 Unfollow Testing
	S86 Auto Post to Groups
	S87 Facebook Groups


	T90 Instagram




	Invest Team		Investing Orga			IO01 Investing Butlers
	IO02 Investing Team Keywords
	IO05 Investing Doc Pages


	I40 Golden Visa			I41 Greece Golden Visa
	I42 Real Estate Lawyer


	I50 Real Estate			I50 Greek Real Estate				I51 Location Price Overview
	I53 Greece Real Estate Agent
	I55 Tax
	Mortgage






	Orga Tools		O00 Orga Pages (mig all)			O01 Orga Butlers
	O02 Orga Keywords (mig)
	O05 Orga Doc Pages (mig)
	O06 Doc, Trello Migrate to Teams (mig)


	O10 Orga Videos			O12 Vimeo Organisation


	O20 Confluence			O21 Confluence Site Admin
	O22 ToDo and Bugs April
	O23 Confluence Notifications
	O24 Confluence Cancellation
	PRIV O25 Tasks Team


	O30 Way of Work			O31 Way of work
	OT10 Tasks, Task Steps, Areas
	O34 Kanban
	O35 Sprint Backlog
	O37 CodeStore
	O38 Def of Done Process
	O39 Latest Sprint Folder


	O40 Doc Pages			O41 Minimum Doc
	O42 Structure: Menu, Album, Motherpage
	O43 Page, Title, URL, Page Numbering
	PRIV O44 Page Format
	PRIV O45 Sections/Chapters
	PRIV O45a Table of Content and Glossary
	PRIV O45b Glossary
	O46 Problem, Solution, Result Screen
	O47 Screenshots and Text Upload
	O48 Video on Doc Site
	PRIV O49 Doc Pages Cleanup
	PRIV O49a Old Doc Pages Rules, Needs Cleanup
	PRIV O49b Doc Pages and Trello Cards (cleanup required)
	O49x Doc Pages Old


	O50 Trello Basis			O50a Account Settings
	O51 Trello Teams / Workspaces				O51a Authors Team
	O51b Backups Team
	O51c Group Team
	O51d Investing Team
	O51e Orga&Trello Team
	O51f Private Team
	O51g SEO Team
	O51h Sports Team
	O51i Tools Team
	O51j WordPress Team
	O51k Work Team


	O51a Trello Members
	O52 Boards
	O52b Backlog Boards
	O52c Old Sprints
	O52d Doc Boards
	O52f Archived Sprints
	O53 Trello Labels
	O54 Trello Lists
	O55 Trello Attachments
	O56 Trello Cards
	O57 Trello Backup
	O58 Trello Checklists
	O58a Doc Task Backlog (Open)				L03a Documentation Tasks


	O58b Def of Done
	O59 Trello Custom Fields


	O60 Trello PowerUps			O61 PowerUps Howto
	O62 Custom Powerups
	O67 Browser Extensions for Trello
	O68 Story Points


	O70 Trello API			O71 Merge by Column
	O77 Empty Trash
	O72 Merge by PageNo
	O73 Merge by Keyword
	O76 Trello to WordPress


	O80 Trello Butler (mig)			O80a Trello Butler List (old)
	O81 Syntax (Mig)
	O82 Move Cards based on Keywords (mig)
	O83 Due Dates (mig)
	O84 Sort Cards and Lists (mig)
	O85 Card Buttons (Mig)
	O86 Archiving,Controls, Rename
	O87 Rules Command Libraries
	O88 Checklists&Merge Cards
	O89 Butler Account, Quota


	O90 Planning Tools			O91 Calendar Apps
	O92 Google Calendar
	O93 Cronofy
	O94 Calendar Analytics
	O95 Teams Setup (Mig)
	O96 PomoDoneApp Problems + Improve
	O97 Zapier
	O98 Slack




	Private		Harry Mail			HM10 Banks				HM11 Accounts and Cards
	PRIV HM12 UBS Ebanking
	HM12 Credit Card Fees
	HM13 Depot
	HM16 Russia Interest Rates


	HM20 Amazon (mig)				HM24 Amazon 2019-2021 (mig)
	HM27 Amazon 2018 (mig)
	HM28 Kindle (mig)


	HM30 Ebay (Migr)				Pr21 Ebay Lists (Mig)
	Pr22 Ebay 2017 (migr)
	Pr23 Ebay 2018 (migr)
	Pr24 Rappoport 2019 (migr)
	Pr25 Ebay gemo 2017 (migr)
	Pr26 Rappoport 2020 (Migr)
	Pr26 Rappoport 2021 (mig)
	Pr26 Gemo 2020 (migr)
	Pr27 Sales Books (migr)
	Pr28 Power
	Pr29 Ebay Sales (mig)


	HM80 Transport				PRIV Pr61 Tarifzonen Hüntwangen
	Pr62 Packages in Germany for Swiss


	HM90 Travel Flight				PRIV Pr82 Konstanz-Stein am Rhein-Schaffhausen
	HM84 US Holidays
	PRIV Pr85 Travel Trier
	PRIV Pr86 Geotracking
	Pr88 1000 euro World
	Pr89 Armenia Tpiur




	Kat + Geo			KG90 Russia				KG91 Visa for Russia


	KG40 Food				KG41 Hello Fresh
	KG42 Onlineshop (Conf)




	PO Private Orga			PO01 Private Butlers
	PO02 Keywords Private Team
	PO05 Private Doc Pages
	PO06 Sites used for Private


	Swiss Mail			SM10 Bike				SM11 Garmin Edge Comparison
	SM12 Polar FT40, FT60, FT80


	SM20 Flats				SM21 Schuppistrasse
	SM22 Flat Offers
	SM23 Distance Flat Work
	SM26 Wohnungsbaugenossenschafen


	SM40 Job				SM41 CCP
	SM42 Netting Details
	SM43 Matching Rules Real Time Settlement (RTS)
	Sm44 Books Records
	SM49Glossary


	Sm80 Tax Law				SM81 Tax Comparison
	SM85 Legal Protection Switzerland




	Health
	Stuff (fully Migrated)			St10 Digital (mig)				St11 Audible German Books (mig)
	Pr16 Phone Tablet (mig)


	St30 Scanning (mig)
	St40 Electronics (mig)
	St20 basement				St27 Container (mig)




	ST50 Private Invoices (mig)
	Job			PRIV Pr51 CS Teams
	PRIV Pr52 CS Calculation Rates
	PRIV Pr55 Language
	Pr56 Satipatthāna Achtsamkeit


	Pr90 Private Tasks			PRIV Pr91 George2016.06
	PRIV Pr92 George 2016.07
	PRIV Pr97 Concatenate Excel


	Pr99 Private Doc Pages


	SEO Rankup Product		SP10 Product			SP14 Mentor Product Feedback


	SP20 Competitors			SP21 Syndication Comparison
	SP23 Backlinking Competitors


	SP30 SEO USP			SP51 SEO USP Details


	SP50 Content Sourcing			SP31 Keywords
	SP32 Input Sites
	SP33 Satellite-Site
	SP34 Feeds Creation
	SP35 Load Content				Sa51 Gather Content




	SP40 Site			SP41 Sahifa Settings


	SP41 Site Creation
	SP70 Auto-Translate
	SP80 Spinning			SP81 Spinning Software and Quality
	SP81a providers / competitors
	SP82 Spinning in other languages
	SP83 Spinning Prototype
	SP84 Software Used
	SP85 Spinning in Syndic Tools
	SP86 Spinning into FeedWP
	SP87 HTML into Spinning Text
	SP89 Spinning Legal&Google
	SP88 Keywords not to be spinned


	SP90 Backlink			Sa810 Sales Text




	SEO Company		S00 SEO Orga			SO01 SEO Butlers
	SO02 Keywords SEO Team
	SC03 Cronofy SEO Team
	S02 Business Calendar
	SC04 File System
	SO05 SEO Doc Pages
	SC05 Client Invoices
	SC06 Supplier Bills


	S10 SEO Brand			SB11 Name
	SB13 Vision/Purpose
	SB14 Brand
	SB15 Owner
	SB16 Domain
	SB17 Amprise May 12
	SB18 RankUp Logo
	SB19 Project Plan


	S20 Customer/Market			SC21 Customer
	SC SEO Validation
	SC25 EasyBacklinks Client Offers
	SC26 SEO Market
	SC27 Sales Plan


	S30 Campaign			SC33 SEO Campaigns


	S40 Income			S41 Revenue Model
	S43 Cashflow
	SI20 EasyBacklinks Forecasts


	S50 SEO Risks			S51 Risks on Content
	S52 Risk: Emotions


	S60 Project plan			S61 Monthly Plan
	S63 Weekly Plan
	S66 Client Project Plan Gold
	S67 ONYX Plan
	S68 ONYX Websites


	S70 Company Material			S71 Hotseats and Feedback
	S72 SEO Corporate Materials
	S77 Company Calendar


	S80 SEO Concepts			S75 Index Coverage
	S71 Domain Authority
	S83 Offsite SEO
	Internal SEO
	S85 Black-Hat SEO
	S86 Duplicate Content
	S86 Domain seo
	S89 Private BlogNetworks
	SEO Tools Comparison


	S90 SEO Tools


	Sports Team		Sports Orga			He01 Health Butlers
	SO02 Sports Keywords
	SO05 Sports Doc Pages


	Sp10 Sports Tools			Sp11 Garmin Connect
	Sp12 Strong
	Sp13 Apple Health
	Sp22 MyFitnessPal Integrations


	Sp20 Calories			Sp21 Calorie calculators
	Sp23 Körperfettwaage




	Tools Team		Files			V00 Clouds				V01 Cloud Providers
	V06 Mega
	V05 Onedrive


	V10 Dropbox, Google, Apple				V12 Dropbox Content & Referral
	V13 Space on Dropbox
	V14 Other Settings Dropbox
	V15 Google Drive
	V16 Google Drive Setup and Share
	V17 Apple
	PRIV V19 Conflicted Files


	V20 Pcloud				V21 PCloud Setup (not)
	V22 Pcloud Accounts (mig)
	V23 Pcloud File Share (not)
	V24 Pcloud Files (not)
	V24a Pcloud Restore (mig)
	V24a Pcloud Backup (not)
	V25 Pcloud Problems/Solutions (mig)
	V27 Pcloud Sync (Mig)
	V26 Pcloud Bugs (Mig)
	V28 Pcloud Sync Problems (Mig with I)
	V29 Pcloud Trash


	V30 Sync.com				V31 Sync.com Installation
	V32 Sync Settings
	V33 File Selection
	V34 Shares
	V35 Program Settings to Sync
	V36 Speed
	V38 Problems with Files


	V40 IDrive (mig)				V41 Idrive Account (mig)
	V42 Idrive Backup (mig)
	V44 Idrive Problems (mig)


	V50 Films (Migr incl Sub)				PRIV V51 RatDVD Conversion
	V52 RatDVD into VOB
	PRIV V53 Convert into MKV
	V54 Duplicate and Cleanup Films
	PRIV V55 Download Film
	PRIV V56 Subtitles
	V57 Film Attributes & Conversion
	PRIV V58 Russian Films
	PRIV V59 Other Films


	V60 File Tools				V61 File Types (Mig)
	V62 Order Files: FileJuggler
	V63 Order Files: DropIt, PhotoMove
	V64 File Synchronization Tools (Mig)
	V65 File Deletion Tools (mig)
	V66 File Rename Tools
	V67 Encryption Tools
	V68 File Search Tools
	V69 WindirStat


	V70 My data				V71 My Data
	V72a File Cleanup
	V72File Cleanup
	V73 Location Script (Mig)
	V74 Audio
	V75 Movies
	PRIV V76 Documents
	V77 Photos
	PRIV V78 Team					V782 Team Folder Backup


	V79 Useful Info
	V79a Devices					V791 Desktops


	V79b Quarterly


	V80 Bookmarks				V81 Online Bookmarks (mig)
	V82 Bookmarks Import Export
	V82b Bookmarks Backup
	V83 Bookmarks Sync
	V84 Useful Info from Bookmarks
	V86 Bookmark Cleanup
	V85 Magadoo
	PRIV V88 PearlTrees
	V89 Bookmarks from Trello


	V90 Text Formats				V91 PDF to HTML
	V92 PDF Explorer
	V93 PDF into WordPress					V93b Converting Tool Test


	V94 Searchable PDF
	V95 PDF Tables Conversion
	V96 PDF Tools
	V97a Import Word Test
	V97c Import Word Example
	V98 Slides from PowerPoint
	V99 Office




	Computer			CM00 Disk Space				CM01 Drives&Partitions
	CM02 Boot
	CM02b Multi Boot Tools
	CM07 HP Elite BIOS
	CM03 Space (mig)
	CM06 System Restore
	CM05 System Settings


	CM10 Windows (Mig all)				CM11 Windows Installation (Mig)
	CM11b New or Updated Computer (mig)
	CM12 Windows Activation (mig,no image needed)
	CM12b Windows Activation Script (Mig)
	CM13 Windows File Access (mig)
	CM14 Users on Windows (migr)
	CM15 Power Management (mig)
	CM16 Windows Services (empty)
	CM17 Windows Indexing (mig)
	CM18 Files/Network on Windows (Mig)
	CM19 Windows Admin Other (mig)(


	CM20 Software				CM21 Installation SW Table
	CM21a Programs Elite
	CM22 Install SW Explain
	CM23 Revo Uninstaller (no Pic needed)					CM23b Revo Uninstaller Import Logs


	CM24 Program Shortcuts
	CM24b Shortcut Fixes
	CM25 Autostart
	CM26 Ccleaner
	CM27 Dependent Software
	CM28 Office
	CM29 List of Services


	CM30 Portable Software				CM31 Base Software Portable
	CM32 Portable Software Explain
	CM33 Installation Folder
	CM34 Installed SW Location
	CM35 Portable Apps Framework
	CM36 Portable Apps Download
	CM37 Portable Apps Install (mig)
	CM38 Portable Apps Sync with Table
	CM39 Problems Portable


	CM40 Remote (Sufficient Mig)				CM41 Remote Desktop Solution (mig,no pic)
	CM43 Teamviewer
	CM44 Radmin (mig,nopic)
	CM45 GotomyPC
	CM46 Microsoft Remote Desktop					CM46b Microsoft Remote Desktop Problems


	CM47 Sadeem RDP
	CM47A Babushka Remote
	CM48 Wake on LAN (mig)
	CM49 Anydesk / RemotePC


	CM50 Privacy & Security				CM51 Firewall					CM51a Windows Firewall
	CM51b TinyWall
	CM51c Fab Firewall


	CM52 Antivirus					CM52a Kaspersky Antivirus


	CM55 Passwords					CM55a Keepass
	CM55c Bitwarden
	CM55d Avast Passwords


	CM57 VPN (Mig)
	CM58 My IP / Data
	CM59 VPN for Browser (mig)					CM59d Browser VPN (mig)




	CM60 Software Comparison (migr)				CM61 Software Donate (migr)
	CM62 OBS Recording (migr)
	CM64 Disk&DVD (migr)
	CM66 Zoom (Migr)
	CM65 Meeting Sharing Solution (Migr)


	CM80 Windows Registry				CM82 Registry
	CM83 File Associations
	CM87 Preview Handlers


	CM90 Communication				PRIV CM91 Whatsapp Desktop
	CM92 Skype
	CM93 Telegram Data


	CM99 Computer Menu Cleanup


	Hardware			H20 Comp Devices				H21 Computer (pic missing)
	H22 BIOS Config
	H23 Computer Disks (mig)
	H24 External drives
	H25 Scanners
	H25b Printers
	H26 USB Hubs
	H27 Audio Devices
	H28 Routers (mig)
	H29 Drivers


	H30 Screen				H31 Resolution
	H32 Graphics Adapter
	H33 Pixel and Viewing Distance
	H34 Monitor Comparison
	H35 My Screens
	H36 Mac Display
	H38 Pixel Density


	H70 NAS Admin & Hardware (mig incl. Subpages)				H71 NAS Devices
	H72 NAS Disks (>1 TB)
	H72a NAS Disks (>1 TB) tests
	H72b NAS Disks Problems
	H74 Storage Pools (MigXIm)
	H74 Volumes
	H75 NAS Network
	H77 NAS Problems
	H78 Remote Access NAS
	H79 External Device NAS (Mig)


	H80 Files & Software on NAS (mig)				H81 Shared Folder (mig)
	H82 SMB & Map Drives
	H83 File Permissions and Access (mig)
	H84 File Station
	H85 Hyperbackup and NAS Jobs (mig)
	H86 HyperBackup Integrity and Advanced Issues
	H86 Drive Backup Solution
	H87 Computer Files Backup


	H90 Media on NAS				H93 Video on NAS




	Comp Orga			TO01 Tools Trello & Butlers
	TO02 Keywords Tools Team
	TO05 Comp Doc Pages


	Mobile			Mo10 Browser Profile				Mo11 Profile
	Mo12 Profile and Sync
	Mo15 Browser Sync
	Mo18 Firefox and Thunderbird Portable
	Mo19 Iridium Issues


	Mo20 Browser Settings				Mo21 Browser Core Settings
	Mo22 Firefox Settings
	Mo24 Vivaldi Settings vs. Yandex vs Chrome (not needed)
	Mo27 Chrome Command Params
	Mo29 Yandex Protect


	Mo30 Browser Extensions				Mo31 Browser Extensions Details
	Mo32 Domain Block
	Mo37 Local Explorer


	Mo40 Android				Mo42 Import from Android
	Mo44 Android Apps


	Mo50 Iphone Ipad				Mo51 Icloud Settings (not needed)
	Mo52 Icloud Mail
	Mo53 Iphone/Ipad Devices
	Mo54 Iphone/Ipad Problems
	Mo56 Iphone/Ipad Software


	Mo60 Providers				Mo61 Mobile Providers Prices
	Mo62 Unregistered SIM
	Mo63 Lycamobile
	Mo65 SIP Phones
	Mo66 Internet Providers
	Mo67 Switzernet


	Mo70 Other Mobile Devices				CMo71 My Camera
	CMo72 GPS Camera
	Mo73 Sony DSC HX90V


	Mo80 Apple Mac				Mo81 Space on Mac
	Mo83 Mac Software


	Mo90 Laptops				Mo91 ThinkPad T420s
	Mo93 Headsets




	Mail			Ma10 Thb Regular				Ma11 Regular Tasks
	PRIV Ma12 Sanity Checks
	Ma13 Column Layout
	PRIV Мa14 Sync Mail Objects
	Мa15 New Mail Address
	Мa16 Mail Cleanup:Notifications


	Ma30 Thb Setup				PRIV Ma31 Setup
	PRIV Ma32 Setup Alternatives
	Ma33 Profile
	Ma34 Profile Move & Backup
	PRIV Ma35 Account
	PRIV Ma36 Identities
	PRIV Ma37 IMAP File location
	Ma38 Mail Server Configuration


	Ma40 Thb Add-ons (MigrMain)				Ma41 Add-ons Folders (migr)
	Ma42 Add-ons and Thb Version (migr)
	Ma43 Thunderbird Version (Migr)
	Ma44 Add-on Version and installation (migr)
	Ma45 XUL/XPCOM vs. WebExtensions (migr)


	Ma50 Thb Search Tools				PRIV Ma51 Mail Search
	Ma52 Message Filters (rules)
	Ma53 Message Filters Add-ons and Problems
	Ma54 Tags
	Ma54a Our Tags
	PRIV Ma55 New Filter Keywords/Senders
	PRIV Ma56 New Tags and Filters
	PRIV Ma57 Correction of filter rules
	PRIV Ma58 Saved Search


	Ma60 Thb Message Content				Ma61 Mail Folders
	Ma62 People's Address
	PRIV Ma63 Our Thunderbird Folder
	Ma64 Duplicated Mails
	Ma65 Thunderbird Mails Viewing
	Мa66 Notifications
	PRIV Ma67 WP Tags & Keywords
	Ma68 Attachments
	PRIV Ma69 Subject SNB


	Ma80 Gmail				PRIV Mа81 Gmail Account
	PRIV Mа82 Gmail Alias and Secondary Accounts
	PRIV Mа83 Send Mail with Server
	PRIV Mа84 Gmail Lables
	PRIV Mа85 Gmail Message Filters
	PRIV Mа89 Cleanup Gmail


	PRIV Mа90 Other Mail Providers


	IT Sales


	Wordpress Company		WordPress Orga			Project Planning
	WO01 WordPress Butlers
	WO02 Keywords WP Team
	WO05 WP Doc Pages


	Autofeeds			F00 Syndication Alternatives				PRIV F02 Feedly
	F03 RSS Test feed - To be deleted
	F04 Twitter API (Alternative Economics)


	F10 FeedWP Core				F11 Feed Sites - design
	PRIV F12 Feed WordPress Config
	PRIV F13 Import Content & Mapping (old)
	PRIV F14 New Feed
	PRIV F15 Reload Posts
	PRIV F16 Delete Feed
	PRIV F17 Feed WordPress: Questions
	PRIV F18 Transfer Feed
	F19 Auto-Publishing And Manual Editing


	F20 FeedWP Cron				F21 Cron Jobs
	F22 Cron Problems
	F24 Cron Improvements
	F28 Performance Issues Feeds


	F25 FeedWP in WordPress
	F30 Full Posts				PRIV F31 RSS Grabber: Get Full Posts
	F33 FeedWP Advanced Filters
	F32 Rss grabber Problems


	F40 FeedWP Filtering				PRIV F41 Content-Based Feeds
	PRIV F42 Content-Based GUI
	PRIV F43 Output inside WP
	PRIV F44 Backend Improvements
	F49 Bugs


	F50 Media via Feed WP				PRIV F51 File and Size
	PRIV F52 File Attributes
	PRIV F54 Unattached Images
	PRIV F55 Image Sizes for FeedWP
	PRIV F56 RSS and Source URL for Media
	PRIV F57 Testing Duplicate Images
	PRIV F58 FeedWP and Hard Link Protection
	PRIV F59 Media: ALT and Caption


	F60 New Design Core				PRIV F61 Feed WP Redesign
	PRIV F62 FeedWP Wizard
	PRIV F63a Functions Areas Feed
	PRIV F63b Functions Areas Post
	PRIV F63c Functions Areas Authors
	PRIV F63d Functions Areas Categories


	F70 FeedWP Testing				PRIV F74 Test FeedWP & Grabber


	F80 Videos via FeedWP				F81 Link Name
	F84 Video Publish
	F85 Video Filter
	F86 Duplicate Videos


	F90 Youtube				F91 Youtube Feed Design
	F92 Video Post Type
	F93 Youtube API
	F94 Youtube Objects Attributes
	F95 Youtube tag, author-based
	F96 Youtube GUI
	F97 Youtube Sync
	F98 Youtube Display and CSS
	F99 Blacklist and Whitelist


	PRIV F99 Feed WP Menu Cleanup


	Plugins Sales			S31 Aggregation Consultancy: Clients
	S32 Aggregation Consultancy
	S32b WordPress Plugins
	S34 PromoteAuthorTools Sales Page
	S35b USP PromoteAuthorTools
	S37 Promote Author Company
	S37B WPGeist
	S38 PromoteAuthor-Tools Project
	S39 Sale WordPress Plugins
	S39 PromoteAuthors Tools Project
	S39b Social Channels PromoteAuthors


	Media			M00 Media Attributes and Editing				M01 File and Size
	M02 File Attributes
	M03 External Files: Hot Linking
	M04 Attachment Page, Media Title
	M05 Attached or Linked To
	M06 Tags on Media
	M07 ALT, Caption, Description
	M08 RSS and Source URL
	M09 OCR and ALT Text


	M10 Media Library				M11 Media Library
	M12 Media Library Quick Edit
	M13 Media Quick Edit Issues
	M14 Media Library Find and Edit
	M16 Quick Edit Improvements


	M20 Media Inside Post				M21 Upload Media
	M22 Edit Media in Post
	M24 Link to Image
	M25 Media Title Functionality
	M27 Media Caption


	M26 Copy Paste Image into Post				M26a Competition
	M26b Image Elevator
	M26d Image Elevator Enhancements
	M26f Image Elevator Enhance Details
	M26g Image Elevator Enhance Test
	M26h Image Elevator Enhance Problems


	M28 Video Embed				M28a Video into Posts: Competition
	M28b ARVE
	M28c Video Params for Embedding
	M28d Embed via HTML


	M30 Media Classification				M31 Overview Improvements
	M32 Media Object
	M33 Media Post Type
	M34 Video Post Type


	M40 Online Videos				M41 Vimeo
	M42 Vimeo Albums
	M43 Vimeo Folders
	M44 Video Name, Date, Keywords
	M45 Vimeo Recording


	M50 Image View				M51 Image ViewerTools
	M52 Image Popup
	M55 Media Gallery
	M56 Media Gallery Problems
	M57 Text Image Table Gallery


	M60 Media Edit				M61 Regular Task
	M62 Paint Net
	PRIV M63 Paint Net Ico Images
	M64 Screenshot Tool


	M69 OLD WP Other Media
	M70 Media Editing outside WP				M71 Copy Paste into Websites
	M72 Media on Confluence


	M80 Media Tools				M81 Video Recording: Ice Cream
	M83 Video Editing
	M84 Logo, Watermarking
	M85 Video Player
	M86 Audio to Existing Video
	M87 Video Conversion
	M89 GPS Tools


	M999 Media menu Cleanup


	Old Plan 2018			O11  Sprints until 2018
	O12 Sprints 2019
	PRIV O15 Tasks Log
	PRIV O16 Task Backlog (Open)				PRIV L10a Plugin Go-Live Tasks


	PRIV O17 Task Log Archive (closed)				PRIV L20a Task Log - FIXED
	PRIV L20b Task Log Old
	PRIV L20c Rad Work
	PRIV L20d Author Go-Live Bugs October
	PRIV L20e SNBCHF Go-Live Tasks October
	PRIV L20f Sprint page 2015 12 01
	PRIV L20y 04/29
	PRIV L20z Translator Tasks (old)


	PRIV O18 Bug Archive
	PRIV O18c 0901 Test and Bugs September
	PRIV O18d 0924 Bugs September 24
	PRIV O18f Bugs September 28


	Plugins			P00 General Plugins				P01 Content versus Graphical Form
	P02 Own plugins
	P02c Old Plugin Table
	PRIV P03 Translation
	P04 Overriding a WP Plugin
	P05 Custom code
	P06 Other Plugins Merge
	P06 Other plugins
	P07 README File
	P08 Plugin Licensing
	P09 License Protection for Plugins
	P09 Access to Plugins, Pages
	P09 Empty Plugin Code into Output


	P10 Plugins Posts, Pages				P11 Post, Page Overview
	P12 Post Meta Attributes
	PRIV P13 WP-PageNavi
	P17 How to Copy Page
	P18 Post Status
	P19 Delete Drafts with Attached Images


	P20 Plugins for Post Text				PRIV P21 Half Story
	P22 Search Regex (text modification tools)
	PRIV P23 Text Replace Snippets
	P24 Google Custom Search
	PRIV P25 Graphene Message Blocks
	PRIV P26 Automatic Post Checks
	PRIV P27 Post Introducer
	P28 Table of Content (TOC)					P28a Anchor


	P29 Excerpts
	PRIV P29a Related Posts


	P30 Plugins for URL				PRIV P31a How does Wordpress find your post
	PRIV P31b Permalinks, Postname,Slug, URL
	PRIV P31c Category in Permalinks Considered Harmful
	PRIV P31е Change Site URL or Delete
	PRIV P31f Change URL
	PRIV P31g Permalinks on snbchf.com
	PRIV P31h URL Masking
	PRIV P31l Duplicates and Black Boxes
	PRIV P31x Google Go-Live & Permalinks Feedsite
	PRIV P31y Subdomains Links Link Categories
	PRIV P31z Your sub-domain strategy could be seriously harming your SEO
	PRIV P34 Archive Content: New URLs
	PRIV P37 Archive URL Aid
	PRIV P38 WP Backend Slug
	P39 URL Test Procedure


	P35 URL Stop Words				P03l Manual Key Phrases and Tag-based key phrases
	PRIV P35a Overview
	PRIV P35b Run Tools
	PRIV P35c Algorithm
	PRIV P35d Character Rules
	PRIV P35e Lists
	PRIV P35f Stop Word Lists
	PRIV P35g Key-Phrases
	PRIV P35h Tag-Based Lists
	PRIV P35i Ordered Non-Stop Words
	PRIV P35j English Stop Words
	PRIV P35k Stop Words Testing
	PRIV P35l Insignificant Nouns and Common Words
	PRIV P35m Old URL
	PRIV P35n Final S for Plural, 3d person, genitive
	PRIV P35o Non Stop Words, Key-Phrases
	PRIV P35p Stop words in German
	PRIV P35q Numbers
	PRIV P35r Stop Words IT
	PRIV P35y Stop Words Readme (OLD)
	PRIV P35z StopWords Menu


	P40 Plugins for Links (Sharing)				PRIV P41 Share Buttons
	PRIV P42 Related Posts for Introducer
	PRIV P43 Related Posts on Desktop & Mobile


	P50 Plugins for Categories				PRIV P51 Competition & Design Principles
	PRIV P52 Pictured Category Container
	PRIV P53 Widget Pictured-Categories
	PRIV P54 Pictured Category Menu
	PRIV P55 Pictured Category Tiles
	PRIV P56 Archives
	PRIV P57 Pictured Category Archives
	PRIV P58 Sahifa for Pictured Categories
	P59 Categories Backend
	P59b Private Posts and Category


	P60 Plugins for Tags				PRIV P61 Tag Archives
	PRIV P62 Tag-Based Site Competitors
	PRIV P63 Youtube Search-Based
	PRIV P64 Tags on Posts
	P65 Automatic Tag Creation
	P66 Tag Hierarchy
	P67 Term Optimizer
	P68 Tagitizer: Automatic Tag Creation
	P69 New Fields WP Taxonomies & Options
	P69 Tag Integration


	P70 Homepage, Widgets, Menu				P71 Homepages
	PRIV P73 Other Widgets
	PRIV P74 Page Builder Comparison
	P77 Menu Sync


	P80 Security				PRIV P81 Password Protected


	P90 Sales Plugins				PRIV P91 Trigger-Response Plugin
	PRIV P92 PopupCancel
	PRIV P93 Push notifications
	PRIV P94 Story popup
	PRIV P95 AdsManager without Google
	PRIV P96 AdsManager Light
	PRIV P97 Business Idea
	P98 Infinity Dashboard


	PRIV P99 Plugins Cleanup


	Server			D00 Server				PRIV D01 Server Location
	PRIV D01 Complaint and Server Location
	D02 Server Hardware (mig)
	D02a Second Server
	D03 Vesta
	D05 Server Issues
	D06 Performance Test Tools
	D07a Performance Server
	D07b Performance new Server
	D07d Performance Testing Regular
	D08 Server Maintenance
	D09 Performance Improvements


	D10 (Sub) Domains on Server				D11 Change Domain
	PRIV D12 Users/Domains on Server
	PRIV D13 Domain Change Steps
	D15 IP Address
	PRIV D16 DNS Problems


	D20 Server Migration				PRIV D21 Web Hosting Tools
	PRIV D22 Server Configuration
	PRIV D23 Editing Hosts File
	PRIV D24 Server Installation
	PRIV D25 WP Migrate DB
	PRIV D26 WordPress Installation


	D30 Database				D34 Database Problems
	D35 Database Connection


	D40 Regular Maintenance				D41 Regular Tasks
	PRIV D45 Monthly Improvements
	D46 Biweekly (old)
	PRIV D49 Technical Content Tasks (old)


	D50 Security				PRIV D53 WP Security
	PRIV D54 Whitelist IPs


	D60 Domains and Contact				D61 Domain Registration Data
	D62 Our Domain Proposals
	PRIV D63 Email Contact
	D63 Expired Domains
	PRIV D64 Hostgator
	D65 Gandi
	D66 Godaddy
	PRIV D67 Netcup
	PRIV D68 Transfer Domains
	PRIV D69 Old Domains


	D70 Backup Strategy				PRIV D71 Daily DB Backup
	PRIV D72 Backup Buddy
	PRIV D74 Server/File Backup
	PRIV D75 Local Install Backup
	PRIV D75 Server Backup Howto
	PRIV D77 Emergency Backup
	PRIV D79 2nd Backup to NAS


	D80 SSL				PRIV D82 Certificate
	D83 HTTPS Redirect
	PRIV D84 Mixed Insecure content
	PRIV D85 SSL Mail
	PRIV D89 SSL Documentation


	D90 CloudFlare				D91 Cloudflare Benefits
	D92 Cloudfare Implementation
	D93 Cloudfare Problems
	D94 Cloudflare Improvements


	PRIV D99 Design Menu Cleanup


	Software Development			O07 Agile
	O08 Object-Oriented Design


	Syndic Tools			Y00 Common Functionality				Y01 Common Functionality
	PRIV Y02 StopWords Integration


	Y10 Excerpts Meta				Y11 Restore Excerpt without HTML
	PRIV Y12 Make Excerpts Longer
	PRIV Y13 Regenerate Meta Description from Excerpt
	PRIV Y17 Regenerate Attributes


	Y20 Post Links				PRIV Y21 "External Link" Field from WP Feed data
	PRIV Y23 External Post Links


	Y30 Media in FeedWP				PRIV Y31 Image Import
	PRIV Y32 Video/audio Import
	PRIV Y33 Duplicated Images
	PRIV Y34 Links to Media
	Y35 Media Tools
	PRIV Y36 Media Tools Log
	Y37 Title and Media Title
	PRIV Y38 Caption
	PRIV Y39 Other Media Attributes


	Y40 Tags				Y41 Copy Tags from Media into Posts


	Y50 Posts				PRIV Y51 Delete Post with Images
	Y52 Short Post
	PRIV Y53 Remove Duplicate Posts


	Y60 Executions & Test				PRIV Y61 Syndication Execution Stats European
	PRIV Y62 Syndication Execution Stats
	PRIV Y63 Syndication Execution Stats Ecoblogs.ch
	PRIV Y64 Testing Evidences Syndication Tools
	PRIV Y65 Introduction to Testing Syndication Tools
	PRIV Y69 AJAX Chunks


	Y70 Videos				Y71 Videos: Reload Data


	Y99 Syndication Tools Menu Cleanup


	Webdesign			W00 New WP Blog
	W10 Templates				W11 Graphene
	W12 Snbchf home page
	W14 Sahifa
	W15 Supernova
	W16 Flip and Others
	W18 Multi-Web Site Support


	W20 Mobile Sites				W21 Responsive Design
	W22 Mobile SNBCHF
	W23 Mobile Ecoblogs
	W24 Resolutions on SNBCHF
	W25 Test Mobile Phones


	W30 CSS				W31 CSS on Sahifa
	W32 CSS on Graphene
	W33 CSS on Mobile
	W38 Special Characters
	W39 Various CSS Issues


	W40 HTML				W48 Various HTML Issues


	WP Team Doc Pages
	W50 Cache				W51 Browser Cache
	W52 CDN
	W53 Page Cache


	W60 Formatting				W61 Header Images
	W62 Header Images into E-llusion plugin
	W63 Header Images Ecoblogs


	W70 Tables				W71 Table Press
	W72 Table Shortcode
	W73 Tiny Table (MCE)
	W74 Tiny Table Problems
	W74b Tiny Table Mobile Testing
	W75 Auto-Table Creation
	W76 Auto-Table Global GUI
	W77 Auto-Table Post GUI
	W78 Auto-Table Algo
	W79a Auto-Table Single Testing
	W79b Auto-Table Feed Testing
	W79c User Acceptance Test


	W90 Seo Tools				W91 Google Analytics
	W97 Link Exchange


	W99 Graphical menu Cleanup






            

            
			            
                    
        

		
                
         



        
    


    
    
                
                
        
        
	Home › Tools Team › Files › V90 Text Formats › V91 PDF to HTML

    
    	↑ Return to V90 Text Formats

    

    
                


		
	                


		       
		        
			V91 PDF to HTML			        

				
					

			
			
					
		
								
		
		by 
 Nikolay Dimitrov
		
	
		My articles
		
Follow on:

	
				 
Page no: V91
				
							
																
            
                        Table of contents
	1 Option1: PDF-Word-Excel-HTML	1.1 PDF into Word
	1.2 Word into Excel
	1.3 Excel into WordPress



	2 Option2: Extract Images Tools



 

	
Explanation

	
Videos and Pics


	
Option1: PDF-Word-Excel-HTML

	Load PDF into MS Word
	Save it as Excel with Two Columns
	do not lose the images, image right side
	Load Excel into HTML


	
	
PDF into Word

no text

 
	



	
 

Word into Excel



Save as Plain Text

step1: Open the word document you want to convert to an Excel worksheet, and click File or Office Button > Save As. Then select a location you want to put at, and select Plain Text from the drop down list of Save as Type.


Notice
 Note: In Word 2013, click File > Save As > Computer > Browse. 
	

Save Word Fail as Plain Text
      - Click to enlarge


	 
I

Click Save, then click > OK to close the File Conversion dialog. Then close the word document.
	



	step3: Now open Excel, and click Data > From Text. See screenshot:	

Open File in Excel
      - Click to enlarge


	step4: Then in the popping dialog, select the text file you saved at step 1, and click Import.	

Import File Saved from Word
      - Click to enlarge


	
Import Tables from Plain Text

step5: Check Delimited option in the Text Import Wizard – Step 1of 3 dialog, click Next.
	

Delimited Option
      - Click to enlarge


	step6: In this step, check the delimiters you need (if you do not want the data split by delimiters, do not check any option), then click Next.	

Different Options for Delimiters
     - Click to enlarge


	step7: Then you can specify the data format in Step 3 of 3. Click Finish.	

Column Data Format
      - Click to enlarge


	step8: Then select a cell to put the data if you check Existing worksheet. See screenshot:	

Select Cell
      - Click to enlarge


	step9: Click OK. Now you can save the worksheet.	

Word File is Imported to Excel
       - Click to enlarge


	
Excel into WordPress

step10: Use Mammoth plugin to import Excel File as HTML. The Plugin can be found at the bottom of the edit page in wordpress.
	

Plugin for Importing Excel File as HTML
     - Click to enlarge


	
Option2: Extract Images Tools

	Tool1: PDF Shelltools
	Tool2:for example groovypost


	
	
Save PDF

Save the PDF into our usual folders.

 

 
	



	
Extract Images

Extract the images into the folder.
	



	
Extract Text

Extract the text into WordPress

 
	
	
Add images to the right side

 
	


 

 

We would like that a media import of a PDF leads to a new post/page in WordPress/HTML format.

Example of imported PDF from here.

 

This is the HTML that results from PDF copy paste. It is not very nicely formatted:

 

IMAP/POP/SMTP Server Settings for Google Apps

If you want to use an email client on a computer, such as Outlook, Thunderbird, etc.,or on other devices, such as an iPhone, iPod, iPad, Android, etc., use these settings.

NOTES: You must (if you have not already done so, since mid – July, 2011), reset your password. This insures proper password syncing from Kettering LDAP to Google (the syncing process finishes at the top of the hour, every hour).

Please do NOT reset your password until your e-mail data migration completes. The password may be reset to the same as what it already is, as long as it passes the minimum character password length, which is six characters.

Passwords can be changed via WebMail or https://jabber.kettering.edu

Also, you may have to log into Google

Apps and agree to Google’s terms of service before you can make the IMAP or POP connection from your e-mail client/app.

–

https://spoke2.kettering.edu/simplesaml/module.php/core/no_cookie.php?retryURL=https%3A%2F%2Fspoke2.kettering.edu%2Fsimplesaml%2Fsaml2%2Fidp%2FSSOService.php%3Fspentityid%3Dgoogle.com%252Fa%252Fkettering.edu%26cookieTime%3D1458068548%26RelayState%3Dhttps%253A%252F%252Fwww.google.com%252Fa%252Fkettering.edu%252FServiceLogin%253Fservice%253Dmail%2526passive%253Dtrue%2526rm%253Dfalse%2526continue%253Dhttps%25253A%25252F%25252Fmail.google.com%25252Fmail%25252F%2526ss%253D1%2526ltmpl%253Dgooglemail%2526emr%253D1%2526osid%253D1

or simply

https://spoke2.kettering.edu/simplesaml/module.php/core/no_cookie.php?retryURL=https%3A%2F%2Fspoke2.kettering.edu%2Fsimplesaml%2Fsaml2%2Fidp%2FSSOService.php%3Fspentityid%3Dgoogle.com%252Fa%252Fkettering.edu%26cookieTime%3D1458068525%26RelayState%3Dhttps%253A%252F%252Fwww.google.com%252Fa%252Fkettering.edu%252FServiceLogin%253Fservice%253Dmail%2526passive%253Dtrue%2526rm%253Dfalse%2526continue%253Dhttps%25253A%25252F%25252Fmail.google.com%25252Fmail%25252F%2526ss%253D1%2526ltmpl%253Dgooglemail%2526emr%253D1%2526osid%253D1

(Use your normal e-mail user name and password.)

To use IMAP, you will need to enable IMAP in the Google Apps settings. “Mail Settings” => “Forwarding and POP/IMAP” => “IMAP Access:” => “Enable IMAP” Google Apps POP settings will override your e-mail client/app settings for leaving/not – leave messages on the server. To set it in GA, Options => Forwarding and POP/IMAP => Number 2 selection pull – down.

POP Settings:

Server: …

pop.gmail.com

Port: … 995

SSL: …

Yes, you must use SSL

(Google Apps policy)

Username: …

Your full e-mail address (include your login name and the @kettering.edu)

Password: …

Your normal e-mail password (assuming you reset it and it has already synced, as above)

IMAP Settings:

Server: ….

imap.gmail.com

Port: … 993

SSL: …

Yes, you must use SSL (Google Apps policy)

Username: …

Your full e-mail address (include your login name and the @kettering.edu)

Password: …

Your normal e-mail password (assuming you reset it and it has already synced, as above)

SMTP Settings:

(I regardless of whether using POP or IMAP)

Server: ….

smtp.gmail.com

Port: … 587

TLS

or StartTLS:

Yes, use TLS, you must use TLS (Google Apps policy)

SMTPAuth: …

Yes, you must authenticate to (SMTP) relay through Google Apps, see below

Username: …

Your full e-mail address (include your login name and the @kettering.edu)

Password: …

Your normal e-mail password (assuming you reset it and it has already synced, as above)

NOTE for SMTP Auth: For some e-mail clients/apps, there is a simple checkbox that allows using the “same settings as my incoming server”
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